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ABSTRACT 

Inventory data is fundamental in the management of Indonesian floristic richness. Identification is a 

preliminary effort to acquire specimen’s identity which related to many further botanical aspects. 

Identification keys as well as descriptions are usually included in documents of floristic inventory. To use 

these tools, plant identifiers are required to master plant identification terminologies. However, they are 

getting rare and younger botanists show lack of interest in this field. Computerized plant identification keys 

could be a solution to these problems. Here, author provide an example of automatized generation of 

identification keys and descriptions (genus level) using a computer software. The taxa were resulted from 

tree inventories of Begudul—Bali montane forests and the characters were extracted from a book of spot-

characters. Author used Delta System which consists of Delta Editor for editing taxa and characters 

matrices, and Delta Intkey for displaying the interactive identification key. As many as 53 genera were 

successfully displayed as terminal taxa in the conventional key by using 17 characters. Best characters 

based on the value of separating coefficients were displayed in the interactive key. This work shows that 

computerized plant identification key and description makes it possible for users to focus on taxa and 

character matrices, then the computer will the layout of the outputs.  

 

Keywords: characters; computerized; plant morphology; plant taxonomy 

 

INTISARI 

Data inventarisasi menjadi dasar dalam manajemen kekayaan flora Indonesia. Identifikasi 

merupakan hal mendasar untuk mendapatkan identitas suatu spesimen tumbuhan, terkait dengan banyak 

aspek botani selanjutnya. Dokumen inventarisasi flora pada umunya dilengkapi dengan kunci identifikasi 

dan deskripsi. Identifikator dituntut untuk memiliki dasar pengetahuan yang kuat terkait istilah-istilah 

identifikasi tumbuhan untuk dapat menggunakannya. Sayangnya, dewasa ini identifikator tumbuhan 

semakin terbatas dan minat generasi muda dalam bidang ini semakin berkurang. Komputerisasi kunci 

identifikasi dan deskripsi dapat menjadi solusi untuk bermacam permasalahan tersebut. Dalam artikel ini, 

penulis memberikan contoh otomatisasi penyusunan kunci identifikasi (konvensional dan interaktif) 

sekaligus deskripsi tiap takson (level genus). Daftar takson yang digunakan ialah daftar jenis pohon dari 

hutan montana Bedugul—Bali, dan daftar karakter diekstrak dari sebuah buku tentang karakter morfologi 

tumbuhan. Komputerisasi kunci identifikasi tumbuhan dan deskripsi takson dilakukan dengan perangkat 

lunak Delta System, terdiri atas Delta Editor untuk editing matriks takson dan karakter serta Delta Intkey 

untuk menampilkan kunci identifikasi interaktif. Sebanyak 53 genus berhasil disajikan sebagai terminal 

takson pada kunci identifikasi bertakik (konvensional) dengan memanfaatkan 17 karakter morfologi. Pada 

tampilan kunci identifikasi interaktif, daftar karakter dapat diurutkan berdasarkan nilai koefisien separasi. 

Hasil studi ini mendemostrasikan bahwa komputerisasi penyusunan kunci identifikasi dan deskripsi 

memungkinkan pengguna untuk fokus pada daftar takson dan karakter, untuk selanjutnya komputer yang 

akan mengerjakan tampilan keluarannya.  

 

Kata kunci: karakter; komputerisasi; morfologi tumbuhan; taksonomi tumbuhan 

 

PENDAHULUAN 

Indonesia dianugerahi dengan kekayaan 

ragam flora yang menjadikannya sebagai salah 

satu negara dengan julukan ‘megabiodiversitas’ 

(Kusmana & Hikmat, 2015). Sebagai suatu 

lembaga konservasi tumbuhan secara ex situ 

yang merupakan bagian dari Kebun Raya 

Indonesia, Kebun Raya Bali mengkoleksi lebih 

dari 2.000 jenis tumbuhan dengan lebih dari 

20.000 spesimen (Arinasa et al., 2017). 

Kekayaan tersebut sewajarnya dibarengi 

dengan kemampuan sumber daya manusianya 

untuk pengenalan, pemanfaatan berkelanjutan, 

dan konservasi. Menurut (Jarvie & Stevens, 

1998), manajemen sumber daya hayati mutlak 

berdasarkan data inventarisasi. Hal ini 
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contohnya dilakukan oleh Djarwaningsih 

(2016) dengan inventarisasi koleksi 

Euphorbiaceae di Kebun Raya Bali untuk 

penyusunan Flora of Bali, yang direncanakan 

memuat deskripsi takson dan kunci identifikasi.  

Pada umumnya dokumen-dokumen 

inventarisasi flora dilengkapi dengan kunci 

identifikasi dan deskripsi. Jenis kunci 

identifikasi yang paling umum ialah kunci 

dikotomi, terdiri atas kuplet-kuplet (couplets) 

bernomor urut dan tiap-tiap kuplet terdiri atas 2 

(dua) bagian lead (Tofilski, 2018). Jenis lain 

yang kurang umum ialah kunci bertakik 

(bracketed keys) di mana tiap kuplet dapat 

terdiri atas 2 lead atau disebut multiple entry 

(Brach & Song, 2005). Kunci identifikasi pada 

mulanya dibuat secara manual (konvensional), 

kemudian dengan perkembangan teknologi 

komputer dapat dibuat secara otomatis 

(Pankhurst, 1971; Pankhurst, 1970; Watson et 

al., 1988). Dalam hal ini kunci identifikasi 

berbasis komputer (kunci identifikasi 

interaktif) merupakan solusi untuk 3 (tiga) 

permasalahan: kurangnya identifikator 

tumbuhan, tidak lengkapnya informasi botani, 

dan keterbatasan metode identifikasi 

konvensional (Jarvie & Stevens, 1998). 

Identifikasi didefinisikan sebagai proses 

penentuan takson dari suatu spesimen (Dallwitz 

et al., 2000). Identifikasi tumbuhan tetap 

merupakan hal dasar dalam botani (Jacquemart 

et al., 2016). Untuk mengetahui identitas suatu 

spesimen tumbuhan, sampel dapat dicocokkan 

dengan dokumen-dokumen yang memuat 

daftar jenis-jenis tumbuhan, misalnya buku-

buku flora atau monograf, herbarium, atau 

tanaman koleksi di Kebun Raya (Lawrence & 

Hawthorne, 2006). Namun demikian, dalam 

beberapa kesempatan seminar daring tentang 

indentifikasi dan taksonomi tumbuhan, 

narasumber menyebutkan bahwa saat ini telah 

terjadi krisis taksonom/identifikator tumbuhan. 

Tentu saja ini menjadi paradoks di tengah 

ancaman-ancaman yang menyebabkan 

tumbuhan menjadi langka—kehilangan habitat, 

perubahan iklim, dan invasi spesies alien. 

Fenomena bahwa generasi muda enggan untuk 

mendalami morfologi tampaknya terkait 

dengan stereotipe bahwa morfologi adalah ilmu 

yang rumit, penuh dengan hafalan istilah-

istilah, dan mungkin dianggap kuno (misalnya 

dibandingkan dengan teknologi DNA 

Barcoding yang dianggap lebih modern). 

Dalam artikel ini, penulis memberikan 

contoh penggunaan satu program komputer—

Delta System—yang dapat digunakan dalam 

manajemen data inventarisasi flora, pembuatan 

secara otomatis kunci identifikasi konvensional 

dan interaktif, serta deskripsi tiap takson. 

Program komputer ini telah dikembangkan di 

Australia sejak 1980-an (Dallwitz, 1993), 

disediakan secara gratis (Dallwitz et al., 2016), 

telah dimanfaatkan dalam penyusunan flora di 

berbagai belahan dunia (Dallwitz, 1997): Flora 

of China (Brach & Song, 2006), Flora Australia 

Barat (https://florabase.dpaw.wa.gov.au/), dan 

tumbuhan kayu dalam daftar CITES (Richter et 

al., 2014). Namun demikian, pemanfaatannya 

di Indonesia tampaknya masih terbatas. Satu-

satunya contoh yang dijumpai ialah kunci 

identifikasi interaktif untuk pohon di Borneo 

(Jarvie & Ermayanti, 1996). Rangkaian proses 

semacam ini dapat bermanfaat dalam 

pembelajaran morfologi, dan identifikasi 

tumbuhan (Jacquemart et al., 2016; Silva et al., 

2011) sekaligus mendukung kegiatan 

konservasi (Jarvie & Stevens, 1998).  

 

METODE PENELITIAN 

Untuk menyusun kunci identifikasi 

konvensional dan interaktif secara otomatis 

(komputerisasi), diperlukan daftar takson yang 

akan diidentifikasi, daftar karakter (morfologi), 

dan perangkat lunak (software). Dalam studi 

ini, pengelolaan data matriks takson dan 

karakter dilakukan dengan Delta Editor versi 

1.02 (2088) yang merupakan bagian dari the 

Open Delta Suite. File penginstal untuk sistem 

operasi Windows tersedia pada tautan 

https://github.com/AtlasOfLivingAustralia/ope

n-delta/files/4686518/open-delta-1.02-

Installer-NOJRE.exe.zip (diakses pada 25 

Agustus 2020). Perangkat lunak tersebut 

memerlukan Java Runtime Environment yang 

sesuai, dapat diunduh dari 

http://www.java.com.  

 

 

https://florabase.dpaw.wa.gov.au/
https://github.com/AtlasOfLivingAustralia/open-delta/files/4686518/open-delta-1.02-Installer-NOJRE.exe.zip
https://github.com/AtlasOfLivingAustralia/open-delta/files/4686518/open-delta-1.02-Installer-NOJRE.exe.zip
https://github.com/AtlasOfLivingAustralia/open-delta/files/4686518/open-delta-1.02-Installer-NOJRE.exe.zip
http://www.java.com/
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Delta System 

Perangkat lunak ini terdiri atas beberapa 

komponen. Dalam studi ini digunakan 2 di 

antaranya yaitu Delta Editor dan Delta Intkey. 

Delta Editor digunakan dalam penyusunan 

matriks taksa– karakter yang kemudian dapat 

diekspor menjadi kunci identifikasi 

konvensional, kunci identifikasi interaktif, dan 

deskripsi masing-masing takson. Ikhtisar 

program komputer Delta System secara 

lengkap dapat dilihat dalam (Dallwitz, 2005). 

Kunci identifikasi konvensional dan deskripsi 

takson dapat ditampilkan dengan pengolah kata 

populer atau dicetak di atas kertas. Kunci 

identifikasi interaktif (computerized 

indentification key) ditampilkan dengan 

perangkat lunak Delta Intkey (Dallwitz et al., 

2002). Dengan sistem komputer semacam ini, 

karakter-karakter morfologi yang digunakan 

bisa ditampilkan urut berdasarkan karakter 

terbaik (best characters), yaitu karakter dengan 

koefisien separasi (separation coefficient) 

terbesar (Talent et al., 2014). 

 

Daftar Taksa 

Daftar jenis tumbuhan dalam studi ini 

merupakan jenis-jenis pohon dari hutan 

montana Bedugul-Bali (Priyadi et al., 2014; 

Sutomo et al., 2018), untuk daftar genus, 

dilakukan penentuan nama famili, ordo, dan 

kelas dengan perangkat lunak Taxize 

(Chamberlain & Szöcs, 2013) dalam R for 

Windows versi 3.6.3 (R Core Team, 2020). 

Tercatat ada 63 jenis pohon, terdiri atas 53 

genus, 38 famili, 24 ordo, dan 3 kelas 

(Suplemen 1). 

 

Karakter Morfologi (Spot-characters)  

Menurut Taylor (1995), suatu deskripsi 

taksonomi merupakan suatu daftar sifat-sifat 

(properties) suatu takson. Suatu sifat terdiri atas 

sebuah karakter dan satu atau lebih keadaan 

(state). Untuk 53 genus dalam daftar taksa, 

dilakukan penelusuran karakter-karakter 

morfologi penciri (spot-characters) dalam van 

Balgooy et al. (2015). Dalam buku ini secara 

keseluruhan terdaftar 17 karakter dengan total 

119 state. Daftar karakter dan state 

ditabulasikan dalam suatu spreadsheet 

berdampingan dengan daftar taksa (Suplemen 

1) untuk selanjutnya dilakukan input secara 

manual ke Delta Editor (Gambar 1), menurut 

sistem kode yang dijelaskan dalam (M. 

Dallwitz, 1993). State ‘inapplicable’ disajikan 

secara implisit untuk karakter-karakter tertentu, 

dilakukan pada menu View>Character editor. 

Dengan setting ini, ‘inapplicable’ otomatis 

tercentang apabila tidak ada state dalam suatu 

karakter yang sesuai dengan sifat takson yang 

dimaksud. 

 

 

 

 

 
 

 

 

 

 

 

 

Gambar 1. Tampilan matriks taksa (kiri) dan karakter (kanan) pada jendela Delta Editor. Dicontohkan genus 

Syzygium, benang sari banyak ialah state yang sesuai dari karakter bunga (diberi tanda centang). Nomor dalam 

kurung siku menunjukkan urutan spot-characters dalam van Balgooy et al. (2015). Karakter implisit inapplicable 

otomatis tercentang apabila tidak ada karakter lain yang sesuai
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Kunci Identifikasi Konvensional dan 

Interaktif, Deskripsi Takson 

Daftar jenis dan spot-karakter yang telah 

dipilih, dilakukan input melalui opsi 

View>Taxon editor, Character editor pada 

Delta Editor (Gambar 1). Selanjutnya 

dilakukan pengisian tanda centang, melaui 

View>Attribute editor (trees atau grid) untuk 

tiap-tiap karakter yang sesuai pada masing-

masing genus, dengan panduan matriks genus-

karakter yang telah disiapkan sebelumnya (lihat 

bagian Karakter Morfologi). Langkah terakhir 

pada tahap input data ialah menyimpan file 

matriks taksa-karakter ini dengan ekstensi .dlt 

(Suplemen 2).  

Tahap selanjutnya ialah mengekspor 

file .dlt dengan menu File>Export directive 

(Directive type: Intkey), dilanjutkan dengan 

View>Action set yang memunculkan satu 

jendela baru dengan 4 (empat) tab: Confor, 

Intkey, Dist, dan Key. Pada tab Confor 

dilakukan pencetakan daftar karakter dalam 

format .rtf (Print the character list – RTF), 

konversi ke dalam format kunci interaktif 

INTKEY (Translate into INTKEY format), 

konversi ke dalam format kunci konvensional 

(Translate into KEY format), dan konversi 

deskripsi tiap takson dalam satu file .rtf, .html 

(Translate into natural language – RTF, single 

file for all taxa; html). Pencetakan kunci 

identifikasi konvensional, format .rtf dan .html, 

dilakukan pada tab Key dengan mengklik 

Action: Confirmatory characters – RTF dan –

HTML. Setiap muncul jendela Query Export 

dilakukan pilihan No, karena sebelumnya telah 

dilakukan Export directives. Berkas keluaran 

(output) .rtf dapat ditemukan pada folder rtf 

sedangkan .html pada folder www. Keluaran .rtf 

(chars.rtf, descrip.rtf, dan key5.rtf) bisa diedit 

lebih lanjut dengan perangkat lunak pengolah 

kata, .html (implicit.html dan key5a.html) 

dengan text editor (misalnya notepad atau 

notepad++) dan ditampilkan dengan peramban 

web (web browser), dan intkey dengan 

perangkat lunak Delta Intkey. Sebagai 

informasi, keluaran-keluaran tersebut dapat 

diterjemahan ke dalam berbagai bahasa dengan 

penerjemahan matriks karakter (Dallwitz, 

2005). Dalam contoh ini, matriks karakter 

dibuat sama dengan sumber aslinya (van 

Balgooy et al., 2015) dalam bahasa inggris.  

 

HASIL DAN PEMBAHASAN 

Sebanyak 52 genus flora pohon hutan 

montana Bedugul tercatat dalam buku Spot-

Characters dengan 1–30 karakter state 

(Suplemen 1). Cyathea ialah satu-satunya 

genus yang tidak terdaftar, untuk itu 

disematkan state daun muda menggulung 

(circinate vernation)–merupakan ciri khas 

tumbuhan paku, pada karakter #8. Bentuk dan 

ukuran daun. Gabungan matriks taksa dan 

karakter dalam format Delta Editor (Gambar 1, 

Suplemen 2) memuat 53 genus dengan 17 

karakter yang masing-masing terdiri atas 2–14 

states (Suplemen 3). Total 23 karakter 

diperoleh dengan enam karakter tambahan 

golongan dalam taksonomi mulai dari kelas 

sampai spesies, hanya ada satu karakter #9. 

Tepi daun, tanpa state ‘inapplicable’ 

(Suplemen 3).  

Contoh tampilan kunci identifikasi 

interaktif dengan Delta Intkey disajikan pada 

Gambar 2, versi lengkap pada Suplemen 4. 

Pada komputer dengan Delta System, tampilan 

semacam ini diperoleh dengan klik ganda 

intkey.exe pada folder hasil eksport file dengan 

ekstensi .dlt, dilanjutkan aktivasi ‘best 

characters’ dengan klik tanda “=”. Gambar 2 

menunjukkan 15 karakter terbaik (Best 

Characters) setelah dipilihnya state <75> 

permukaan daun kasar dari karakter #12. 

Indumen, tekstur dan karakteristik permukaan 

daun (Used Characters). Lima belas karakter 

tersebut ditampilkan secara urut menurut nilai 

koefisien separasi terbesar sampai terkecil. 

Pilihan tersebut menyisakan 4 genus: 

Claoxylon, Ficus, Macaranga, dan Trema 

(Remaining Taxa) dengan mengeliminasi 44 

genus lainnya (Eliminated Taxa). Ficus 

menjadi satu-satunya genus tersisa dengan 

pemilihan state <20> getah putih atau kuning 

pada karakter #3. Eksudat: getah dan resin (data 

tidak ditampikan). Adapun tanpa pilihan ‘best 

characters’, sebanyak 23 karakter dengan 53 

genus ditampilkan pada jendela Intkey (data 

tidak ditampilkan). 
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Gambar 2. Hasil kunci interaktif ditampilkan pada perangkat lunak Delta Intkey. Terdapat 4 jendela: Daftar 

Karakter, Taksa tersisa, Karakter yang telah digunakan, dan Taksa tereliminasi. Pada contoh tersebut ditampilkan 

karakter terbaik (aktif dengan klik tanda “=”) secara berurutan berdasarkan nilai koefisien separasi. Penggunaan satu 

karakter permukaan daun kasar mengeliminasi 49 taksa dengan menyisakan 4: Claoxylon, Ficus, Macaranga, dan 

Trema 
 

Bagian dari kunci identifikasi 

konvensional disajikan pada Gambar 3, adapun 

versi lengkap dilampirkan pada Suplemen 5. 

Delta system menginformasikan terdapat 23 

karakter, 18 digunakan, dan 17 terdapat di 

dalam kunci indentifikasi. Adapun yang 

dimaksud 53 items ialah terminal takson, dalam 

hal ini 53 genus dalam studi ini. Dengan kata 

lain, kunci identifikasi yang dibuat telah 

memuat semua taksa dengan memanfaatkan 17 

dari 23 karakter yang tersedia. Gambar 4 

merupakan bagian dari deskripsi tiap-tiap 

takson, dengan versi lengkap pada Suplemen 6. 

Sebagai catatan deskripsi morfologi tersebut 

merupakan keluaran komputer (ekspor dari file 

dengan ekstensi .dlt), bukan hasil pengetikan 

manual oleh pengguna. 

Pada studi ini telah dihasilkan suatu 

contoh kunci identifikasi interaktif, 

konvensional, dan deskripsi taksa dari data 

flora dengan karakter-karakter identifikasi yang 

sesuai dengan memanfaatkan suatu perangkat 

lunak. Hal semacam ini bisa dianalogikan 

dengan fasilitas mail merge, table of content, 

dan insert index pada aplikasi pengolah kata, di 

mana pengguna bisa fokus kepada materi yang 

ingin ditampilkan dan komputer akan 

mengerjakan layout-nya. Namun demikian, 

praktik semacam ini tampaknya belum begitu 

lazim di masyakarat botani Indonesia. Hal ini 

tercermin dari fakta bahwa meskipun 

penyusunan kunci identifikasi dengan 

komputer telah diinisiasi pada era 1970-an 

(Pankhurst, 1971; Pankhurst, 1970), contoh 

publikasi taksonomi baru-baru ini masih 

menggunakan cara manual dalam penyusunan 

kunci identifikasi (Putri et al., 2015; Keim, 

2017; Damayanto et al., 2019). Hal ini 

tampaknya terkait dengan masalah klasik, yaitu 

hambatan biologiwan dalam pemanfaatan 

teknologi komputer. Padahal, terdapat banyak 

kelebihan penggunaan teknologi komputer 

dalam penyusunan kunci identifikasi 

dibandingkan cara manual. Coleman et al. 

(2010) menekankan bahwa pada era di mana 

para taksonom menjadi semakin langka seperti 

sekarang ini, kunci identifikasi interaktif bisa 

menjadi solusi (terutama untuk non-spesialis). 

Menurut Jarvie & Stevens (1998) kunci 

identifikasi interaktif lebih mudah 

dibandingkan kunci dikotom, dan apabila 

terjadi perubahan (klasifikasi, nama ilmiah) 

kunci semacam ini bisa dimutakhirkan secara 

cepat dan tepat.  
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Gambar 3. Kunci identifikasi konvensional/bertakik (bracketed keys) 

 

 
Gambar 4. Deskripsi tiap-tiap takson terminal, disajikan dalam satu berkas urut menurut alfabet 

Karakter yang digunakan dan 

ditampilkan pada kunci identifikasi (interaktif) 

pada studi ini terbatas pada istilah-istilah untuk 

identifikasi tumbuhan (Harris & Harris, 2001; 

van Balgooy et al., 2015). Dalam hal ini, 

gambar-gambar sebenarnya dapat ditampilkan 

dalam suatu kunci identifikasi interaktif 

(Leggett & Kirchoff, 2011) seperti pada kunci 

identifikasi visual untuk Anggrek Korea (Seo & 

Oh, 2017). Penggunaan gambar tentu saja akan 

mempermudah identifikator karena tidak harus 

memahami istilah-istilah morfologi untuk 

tujuan identifikasi, hanya perlu mengandalkan 

kemampuan pengenalan karakter-karakter 

secara visual. Hal ini sesuai dengan penjelasan 

dalam deskripsi WebiKey (Attigala et al., 

2016). Dengan demikian, kunci identifikasi 

interaktif flora pohon hutan montana Bedugul 

ini masih dapat dikembangkan lagi dengan 

menambahkan gambar-gambar karakter 

morfologi untuk mempermudah 

penggunaannya. Fleksibilitas dalam 

penyusunan matriks taksa dan karakter dengan 

Delta Editor juga dapat mempermudah seorang 

pemula untuk mempelajari karakter-karakter 

morfologi untuk tujuan identifikasi. Pada 

awalnya dapat dibuat daftar takson dan karakter 

beserta state yang sudah familiar, kemudian 

dilanjutkan dengan penyusunan kunci 

identifikasi dan deskripsi. Selanjutnya bisa 

ditambahkan takson-takson ataupun karakter-

karakter yang baru dipelajari (belum familiar) 

pada matriks yang telah dibuat sebelumnya, 

diikuti dengan penyusunan kunci identifikasi 

dan deskripsi. Demikian siklus ini diulang-

ulang sehingga seorang pemula pada akhirnya 

dapat menjadi mahir.  
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Hasil studi ini murni berdasarkan 

karakter-karakter dalam van Balgooy et al. 

(2015), tanpa pengamatan spesimen secara 

langsung. Meskipun rangkaian proses yang 

disajikan dalam artikel ini dapat 

mendemonstrasikan otomatisasi penyusunan 

kunci identifikasi dan deskripsi takson, namun 

kesesuaian karakter dalam kunci dan deskripsi 

dengan spesimen perlu divalidasi lebih lanjut, 

terutama state ‘inapplicable’. Pada studi ini, 

pada satu sisi peniadaan state ‘inapplicable’ 

mengakibatkan ekspor file .dlt menjadi format 

Intkey atau kunci konvensional tidak dapat 

dilakukan. Pada sisi lainnya, penyematannya 

menyebabkan ‘inapplicable’ tersebar di lead 

maupun couplet kunci konvensional, yang 

dapat menyebabkan kesulitan dalam 

penggunaan kunci tersebut. Dalam hal ini, 

‘inapplicable’ seharunya dapat diganti dengan 

karakter-karakter yang benar-benar ada pada 

spesimen. Hal-hal ini yang perlu diperhatikan 

dalam validasi kunci indentifikasi dan deskripsi 

berbasis spesimen. Selain itu, buku 

indentifikasi tambahan bisa dijadikan panduan, 

misalnya “Indentifikasi tumbuhan berkayu 

tropis” (Keller, 1996). 

Delta System merupakan satu dari 

banyak perangkat lunak untuk tujuan 

manajemen data inventaris (inventory data), 

termasuk flora. Sistem serupa tersedia misalnya 

Act Key (Brach & Song, 2005), Lucid (Bittrich 

et al., 2012), dan WebiKey (Attigala et al., 

2016). Sistem-sistem tersebut dikembangkan 

untuk otomatisasi penyusunan kunci 

identifikasi (utamanya interaktif). Untuk tujuan 

pengeditan, tersedia juga perangkat lunak 

khusus misalnya DKey (Tofilski, 2018). 

Keluaran dari Delta System dapat diedit lebih 

lanjut dengan DKey apabila diperlukan. Selain 

itu, telah dikembangkan juga perangkat-

perangkat lunak pendukung, misalnya 

monographaR dengan tujuan khusus untuk 

penyusunan monograf taksonomi (Reginato, 

2016). Attigala et al. (2016) membandingkan 

WebiKey dengan beberapa perangkat sejenis, 

salah satunya Intkey. Mereka mengklaim 

bahwa WebiKey lebih modern karena berbasis 

web. Namun demikian, Delta System telah 

dikembangkan sejak lama (Dallwitz, 1993), 

telah diakui sebagai standard oleh Taxonomic 

Database Working Group–TDWG (Jarvie & 

Stevens, 1998), dan sistem ini sudah banyak 

dimanfaatkan dalam manajemen inventarisasi 

flora dengan berbagai skala (Dallwitz, 1997). 

Dengan demikian, Delta System merupakan 

salah satu pilihan terbaik. Terlebih lagi, sistem 

ini masih terus dikembangkan dan disediakan 

secara gratis.  

Hasil kegiatan yang dipaparkan dalam 

naskah ini lebih menitikberatkan pada proses 

penyusunan secara otomatis kunci identifikasi 

dan deskripsi dari matriks taksa dan karakter 

menggunakan perangkat lunak. Pada 

kenyataannya, telah banyak contoh kunci 

identifikasi yang telah dibuat dan 

dipublikasikan dengan metode serupa, 

misalnya untuk kawasan Malesia tersedia kunci 

interaktif Intkey untuk level famili (Malesian 

Key Group, 2004) dan dilaporkan akan 

dikembangkan dalam format eFlora (Roos et 

al., 2011), kunci identifikasi interaktif untuk 

Tabebuia (Santo et al., 2013), dan kunci 

identifikasi tumbuhan paku Kawasan Amazon 

(Zuquim et al., 2017). Contoh-contoh basis data 

kunci interaktif yang dibuat dengan Delta 

System dapat dilihat dan diunduh secara gratis 

dari situsnya (https://www.delta-

intkey.com/www/data.htm, diakses 09 

September 2020). Contoh-contoh kunci 

interaktif tersebut dapat menjadi acuan 

pengembangan kunci-kunci identifikasi serupa, 

sebagaimana hasil penyusunan kunci 

identifikasi dan deskripsi yang disajikan pada 

naskah ini.  

 

KESIMPULAN 

Perangkat lunak Delta System merupakan 

satu pilihan untuk mendokumentasikan data 

inventaris flora dalam matriks taksa dan 

karakter yang pada gilirannya dapat dikonversi 

menjadi kunci identifikasi konvensional 

maupun interaktif dan deskripsi. Pengguna 

hanya perlu fokus kepada kedua matriks dan 

komputer yang akan mengerjakan layout kunci 

identifikasi dan deskripsi. Studi ini berhasil 

memberikan contoh dengan 53 genus flora 

pohon hutan montana Bedugul, Bali dan 17 

karakter beserta state yang sesuai. Mengingat 

karakter yang digunakan murni berdasarkan 

buku Spot-Characters, perlu dilakukan validasi 

https://www.delta-intkey.com/www/data.htm
https://www.delta-intkey.com/www/data.htm
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karakter berdasarkan pengamatan spesimen. 

Penambahan gambar-gambar karakter 

morfologi selain istilah-istilah identifikasi 

tumbuhan juga akan mempermudah 

penggunaan kunci identifikasi interaktif oleh 

para pemula dan non-spesialis.   
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